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Introduction

Nearly 50 years of cutting excellence

At Hypertherm, our sole focus is cutting. Every Associate — from our engineers to our
manufacturing and service teams — is completely focused on providing our customers with the
best cutting solutions in the industry. It's a mission stretching back nearly 50 years to our first
industrial cutting patent. Today, our patent wall continues to expand as we innovate tirelessly
to introduce new plasma, laser and waterjet technologies and services that will help industry
achieve optimal cutting outcomes that support their business objectives. So, whether you're
cutting precision parts in North America, constructing a pipeline in Norway, fabricating
agricultural machinery in Brazil, gouging out welds in the mines of South Africa, or building a
skyscraper in China, you can count on Hypertherm. No matter what you cut, where you cut, or
how you cut, we are here to guide you toward the cutting solution that is right for you.

ProNest is an industry leading CAD/CAM nesting software for advanced mechanized cutting.
It provides a single solution for profile cutting needs including plasma, laser, waterjet, and
oxy/fuel. It is specifically designed to help fabricators and manufacturers increase material
savings, boost productivity, lower operating costs, and improve part quality.

Why does industry choose ProNest?

Process expertise

ProNest does more than any other software to automatically embed cut process expertise into
the NC code. Whether it’s material type, thickness, or grade, ProNest is drawing on years of
research and development to deliver the optimal adjustments including leads, separations, kerf,
feedrate, and cutting techniques.

Breakthrough technologies

ProNest is brought to you by the cutting experts at Hypertherm. This allows you to leverage
breakthrough cutting technologies like True Hole® and Rapid Part™, which are delivered
automatically without operator intervention, and True Bevel™ which greatly reduces bevel set
up time.

Ease of use

Users agree that ProNest is surprisingly easy to learn and use, particularly compared to other
advanced nesting products. Our intuitive software only requires one interface, and users do not
have to switch between different programs to complete the job. Production teams will be up
and running faster, and will be able to complete the job in fewer steps.
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Notes:

This material has been provided specifically for Hypertherm Educational Partners to act as a
teacher’s aide. This material is not intended to represent a complete ProNest® training
document.

The following tasks are based on a Hypertherm plasma machine set-up. The “EdgePro 9_74
HPR400XDa ArcGlide (All, TrueHole, N2M, N2CM) ArcWriter” machine configuration/setup file
is provided with this curriculum and is recommended for this program. Students should add this
machine to ProNest and set as the default. Also required is the demo oxyfuel machine which is
already included in the initial ProNest installation. If other machine configurations are used to
administer this program, the actual results will be different than the documented results.
Please consult with your Hypertherm CAM representative for assistance with making the
required modifications.
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CAD GEOMETRY - understand how to bring geometry into ProNest.

The Parts List
The ProNest part list contains all of the parts that you have added to your job. When you

import

part files into your job from a part source, ProNest processes these files and then adds

them to the part list. Added parts contain all of the information from the source file as well as
the nesting information that was added when the part was imported.

Edit Part
List =
Parts =

PS -

Edi
L

p

The editing of a job's part list is done in the Edit Part List window. From this window you can
build a part list for your job by importing part source files into ProNest and adding properties to
those parts.
— o — |
k) Edit Part Lict (1
(i« Edit View Database [ Return to Nesting s a
A:ulgm ] Refresh | ') Plate List... | [ 2D cAD...
El‘.Snur(es ) Preview o x
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¥ E Sy v Pljw Files of type: AutoCAD files (*.dwg;".dxf) ~ || Filter = = ﬁ
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Part Geometry
There are six (6) methods for bringing geometry (parts) into the ProNest Parts List including:
1. Draw in AutoCAD or other compliant software and bring into ProNest as a .dxf or other

file format.
Part Sources

@ caD |l work Orders |#2] vsP |C#) Pipe | Library | T2 Assemblies

2. Import parts through an MRP/ERP interface to create Work Orders.

Part Sources

caD |[E Work Orders |#] vsp | B Pipe | Library |'FZ Assemblies

3. Modify an existing shape from the Variable Shape Parts (VSP) Library.

Part Sources

cap | [ Work Orders |#2) vsP |Cg) Pipe | Library | B2 Assemblies

4. Modify an existing shape from the Pipe Parametric Library.

Part Sources

caD | [ work Orders |#5) vsP |[5] Pipe | Library |TZ Assemblies

5. Use parts previously saved within the ProNest Parts Library.

Part Sources

caD | [ Work Orders |#3] vsp | (g Pipe|ﬁ Library | T2 Assemblies

6. Use one of ProNest’s “Optional Interface Modules” to import profiles or assemblies
directly from 3D CAD or other specialty programs.

Part Sources

caD | [ work Orders |#3) vsP (5] Pipe | Library |'TE Assemblies
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TASK - The Parts List: For methods 1, 3, 4 & 5 above, write down the procedures and basic
steps taken to create and import each into ProNest.

1. Extract a part from your assignment and save it as a *.dxf file, import into ProNest for
use in a nest.
e Open ProNest, open the edit part list, navigate to the folder containing the *.dxf,
add the file to the part list.

3. Modify a General Rectangle 4” x 8” in ProNest VSP for use in a nest.
e Open ProNest, open the edit part list, click the VSP tab, open the General
Rectangle, edit the dimensions, add to the part list.

4. Open the Pipe module in ProNest. Modify O/D to 12” I/D to 5” and define 5 holes of 1”
dia. on a 5 1/2” dia. Flange. Next, modify a Segmented Elbow in the ProNest VSP with a
90° angle. Make both parts available for use in a nest.

e Open ProNest, open the edit part list, click the Pipe tab, open the Flange and/or
the Segmented Elbow, edit the dimensions, add to the part list.

5. Open the Parts Library in ProNest. Make the part Circle.dxf available for use in a nest.
e Open ProNest, open the Part Library in the Database tab. Click on “new”.
Navigate to the “Program Data\Hypertherm CAM\ProNest 2017\Examples”
directory. Select Base Plate.dxf and Circle.dxf and click OK. Within the
properties select MS .375 and a QTY of 5 each. Close the Parts Library window.
Select Circle.dxf and add to the Parts List.
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DEFINE PART LIST (1) - understand the most common ways to define the part list and
related job specifications in ProNest.

TASK - Parts: For this task, use the provided Hypertherm plasma machine set-up (it may be
useful to set this machine as your default). Open PN and go to the Edit Part List. Under the CAD
tab, navigate to the Examples folder (Program Data -> Hypertherm CAM -> ProNest 2017 ->
Examples).

Select the ArcTrap and add it to the Parts List. List three different ways that you can move this
part to the part list in PN:

e Select the part and press the Add Part button
e Double click on the part

e Drag the part to the Parts List and drop it

TASK - Quantity: Change the quantity of ArcTrap to 20.

Choose three more parts from the examples folder, add these parts to the part list and assign
guantities of 20 to each part.

In addition to the quantity, explain which two additional part attributes (part list fields) must be
assigned a value, before plate nesting can take place:

e Material and Class

Material = The material assigned to the selected part.

Note: When spreadsheets are used for the Process Parameters, the list of available
materials comes from the materials found in your Process Parameters spreadsheet.
When spreadsheets are not used, the list of available materials comes from your
material database.

Class = The cutting parameters for the selected part.

Note: Class can be used to organize your materials using specialized information such as
cutting gas or amperage. Parts with the different classes can't be placed on the same
nest. Available classes come from the Process Parameters spreadsheet.
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TASK - Material: Set Material to MS 0.375 in. and Class to 130Amp 02/Air (True Hole).

TASK - Leads: To display the leads for a selected part, first highlight the part, click the leads
tab in the Properties window (lower right), and then click on an exterior lead in the Preview
window (top right).

Fill in the following lead information from the ArcTrap outer profile:

Lead-in

Style Linear
Size (in.) 0.375
Angle 0
Extension (in.) 0.000
Quality Inherit

TASK - Editing Leads: Leads in PN are assigned automatically based on the built in process
parameters spreadsheets and settings; however leads can be edited if desired.

While Hypertherm parameters are factory tested, what is one reason why you might want to
edit the leads of a part before continuing on to nesting?

e The software sometimes places leads on the sides of parts, but if a small radius corner is
present, this may be a better location for a lead. (This would potentially cause a surface
blemish on the side of the part.)

e [f part quality is not an issue then manually adjusting the leads to a shorter length, while
increasing the potential for part defects, will allow the potential for more parts to be
placed on a nest.

e Using lead styles such as lock, diagonal step, spiral, wiggle and various others can be
beneficial depending upon the cutting process or material being cut.

Describe one other method for editing leads in PN:

e Select a part in the Parts List, open Advanced Edit, select Entity->Modify Leads
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TASK - Special Leads: Why might someone choose to apply Corner Loops to a part?
e Toincrease the sharpness of the finished cut corner
What is one downside of using a corner loop?
e Increased part separations (resulting in decreased plate utilization)
Where in ProNest can corner loops be added?

e Advanced edit

Special Attributes

TASK - Costs: Select the ArcTrap in the Part List. The total cost of the part can be
automatically calculated by PN under the “Utilization and Costing” tab (lower right). While
working with costing, keep in mind that real world ProNest users have their own unique costs
and tracking methods that must be entered into the ProNest setup before accurate costing
results can be produced. The examples below rely on sample data supplied in the standard
configuration/setup installed for this class and are for demonstration purposes only.

Note the total cost and production time difference that occurs as the material thickness

changes:

MS 0.500 in. (130 AMP O2/Air TH) Time 0:00:46 $3.86
MS 0.750 in. (260 AMP O2/Air TH) Time 0:00:43 $5.42
MS 1.000 in. (400 AMP O2/Air TH) Time 0:00:48 $7.22

Perform the material thickness cost test again, but this time change your machine from the
provided Hypertherm plasma machine to the demo oxyfuel machine. Record your results

below:

MS 0.500 in. Time 0:03.05 $12.05
MS 0.750 in. Time 0:04.24 $16.83
MS 1.000 in. Time 0:05.47 $21.08

Name at least two other variables besides material thickness that could also affect the cost of
production:

e Material type, Cutting process, labor rate, material handling equipment
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TASK - Grain: In the Edit Parts List, see Grain restraint angle under Nesting -> Attributes in
the lower right window. Why might a part require the Grain restraint angle applied?

e When bending, setting the part bend lines perpendicular to the material grain will help
avoid fracture.

e For aesthetic requirements, ensure that the part is set in the desired orientation relative
to grain.

Describe when it’s ok, in terms of part quality, to use the Mirror option:

e When the resulting edge angle is not important, e.g. when welding is the next
operation.

TASK - Kerf: Kerf is applied in ProNest via the process parameter table, Kerf values will
automatically change based on certain factors. Name one factor that will cause kerf values to
change:

e Material thickness, speed of cut, amperage use in plasma process, KW used in laser
process, nozzle size of oxy/fuel torch, nozzle size and abrasive used in waterjet.

TASK: Define the final dimensions of a square hole which was drawn 10” x 10” and has no kerf
compensation applied assuming the actual kerf width is 0.14”.

e 9.93”x9.93”

What size would the square hole need to be drawn in order to achieve a finished hole of 10” x
10” assuming actual kerf width of 0.14”?

e 10.07” x10.07”

TASK - Part Import: The faster, automatic way to build a part list in ProNest is to import a
previously created part list, or one that is derived from an ERP or MRP system. Describe the
steps / commands used to import a standard part list file created by an external software
system into ProNest and identify the file extension:

e Goto File-> Open, select Files of type: = ProNest Part List (*.pnl), navigate to the file and
click OK.
* PNL
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NESTING - understand how to nest the part list and what variables are involved in nesting.

What is a nest?

Nests are comprised of parts that have been positioned on a plate in a particular orientation. In
order to create output for a nest in ProNest, a nest must have at least one part added to it.

Below is an example of a nest with 24 parts nested

Nesting can be done manually, where parts are added to the plate one at a time. A part or
group of parts can also be arrayed onto a nest. Nesting can also be done automatically.

Nests are created and modified after parts have been added to the part list. The first phase of
nesting involves adding parts to your nest. Once the parts are nested, many features used to
modify the nest will become available.

TASK - Modifying Parts: What functions can be used to modify parts once they have been
added to a nest?

e They can be moved, rotated, clustered, tabbed, duplicated, and mirrored; cut direction
can be changed; and leads can be adjusted. The plate can be cropped and the cutting
sequence can be changed.

TASK: What is the final function to be used once parts have been added and the nest is
finalized?

e When all modifications have been made, the nest can be saved with your job and then
output as a CNC file.
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Creating a new nest

In the main ProNest window, there is always a default plate to begin nesting on. You can begin
nesting on this plate immediately without explicitly creating a new nest. However, you can
create a new nest at any time using the plate of your choice.

TASK - Nest Creation: What the two (2) methods to create a new nest
e On the Nest tab, click New Nest. =
e -or-
e Click the New Nest tab. F1d
Select the plate and safe zone scheme (if applicable) that you want to use.
Click OK.
Insert a nest

The New Nest / Insert Nest dialog
New Nest 7=

How should ProMest create the new nest?

Use a plate from the Plate List... Safe zone scheme:
[Mone) -

@ Use a custom plate size...
[Rectangular Y] E]

[26.000 x 48000 in. -|

Length (in.): 96
Width {in.): 43

Material:
[[None] b

Cor ) [cone ]

TASK - Inserting Nests: With the “Insert Nest” function, you can create a new nest and
specify where it should be inserted in the nest order in the job. Describe the three (3) steps to
insert a nest that would become nest three (3) in a job with five (5) nests.

e 1. Right-click the nest tab (ﬁ'\ L2 f) to the right of where you want to insert the nest.
e 2.Select Insert.

The Insert Nest dialog will appear.
e 3. Select the plate and safe zone scheme (if applicable) that you want to use.

Click OK.
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Adding parts to the nest manually

With interactive nesting, parts are added from the part list to the nest manually.

TASK - Positioning Part 1: What are the two program components that will affect how

parts are initially positioned when they are manually nested. What default setting must not be
selected to allow these features to function correctly?

e Unselect the “Anchor part to cursor” option below the Part List window.
| ]

Hide depleted parts

[#]:Anchor part to cursor
Options...
B rolar | enend o n x |

e The AutoDrop zone and AutoBump settings (on the Nesting settings page):

e With AutoDrop, parts are initially added to the nest in the same relative spot (in one of
the corners or the center of the plate). The part may be added by Double-clicking the
part in the part list or select the part in the part list and then press ENTER. The part will
initially be placed in the region specified in the AutoDrop zone setting.

Example: If you have AutoDrop zone set to "Upper Right" and AutoBump is off, your
part will automatically be placed in the upper right area of the nest.

If you have AutoDrop zone set to "Upper Right" and AutoBump is active with directions
set to "Down" and "Left", the part would initially be placed in the upper right and then
would be automatically bumped up and then left.
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e Add a part to the current nest without AutoDrop

Click and drag the part from the part list onto the nest. The part will initially be placed
where you release the cursor.

Example:

Because the click and drag method doesn't use AutoDrop zone, as long as AutoBump is

off, your part will automatically be placed on the nest where you release the cursor.

If AutoBump is active, the part will be moved from where you release the cursor in the
AutoBump direction specified in settings.

These settings only control the initial positioning of manually nested parts. Once parts
have been nested, you can move them around freely on the nest.
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TASK - Positioning Part 2: Using the array feature, you can automatically place multiple
copies of a part or group of parts onto a plate, in a specific arrangement. Arrayed parts are
placed as close as possible to one another, based on the part separation value in your settings,
in order to maximize material utilization. Arrays can be applied either automatically or
interactively on a nest.

With what feature can you quickly place parts in a pattern array inside of a rectangular region
on the nest? What benefits does this provide to the operator? that will provide fast manual
nesting with greater control over the size and direction of the array.

e Please see the ProNest 2017 help file for detailed instructions on the use of this feature
(Help -> Nesting -> Arraying Parts -> Dragging to create an array )

e With drag array, you can quickly place parts in a pattern array inside of a rectangular
region on the nest. You can create different array configurations as you drag the mouse
around and see the results on the nest instantly.

e This provides fast manual nesting with greater control over the size and direction of the
array.

Removing parts from the nest

TASK - Removing Parts: Describe the several ways in which parts can be removed from a
nest. What happens to the part properties when it is removed from the nest?

e With the part selected, press the DELETE key
e C(lick and drag the part from the nest back onto the Part List task pane
e Right-click the part and select Delete.

e When a part is removed from the nest, it is returned to the part list and quantities are
reset to reflect the return.
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Part/Nest Seperation Properties

TASK - Seperations: Separation values are applied automatically upon nesting. Identify
where the automatically applied separation values are stored in ProNest:

e Process Parameter Spreadsheets
What are the three different types of separation values?
e Part (to part), pierce (to part), and plate (to part)
Describe why separation values change as material thickness changes:

e Allows greater nest rigidity to counteract thermal movement; provides room for
increased lead sizes; provides sufficient distance between parts to prevent defects

caused by the cutting process, provides distance between parts to protect from spatter
(especially with oxyfuel).

Where can the separation values be changed (if desired) at the nest level?

e Inthe Separations pane (lower left side of the nesting screen) or in the Process
Parameters XLS (see separations tab).
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TASK - Autonest: Proceed to the nesting screen and use the Autonest button A o nest
the previously created part list.

TASK - Seperations: Separation values are applied automatically upon nesting. Identify
where the automatically applied separation values are stored in ProNest:

e Process Parameter Spreadsheets

TASK - Values: What are the three different types of separation values?

e Part (to part), Pierce (to part), and Plate (to part)

TASK - Material: Describe why separation values change as material thickness changes:

e Allows greater nest rigidity to counteract thermal movement; provides room for
increased lead sizes; provides sufficient distance between parts to prevent defects
caused by the cutting process, provides distance between parts to protect from spatter
(especially with oxyfuel).

TASK - Inputs: Where can the separation values be changed (if desired) at the nest level?

e In the Separations pane (lower left side of the nesting screen) or in the Process
Parameters XLS (see separations tab).

Page | 19



DEFINE PART LIST (2) - developing new parts for use in ProNest.

TASK - CAD Drawing: Draw the part shown below in CAD (ProNest 2D CAD if desired) using
proper layer format, ensuring that the ends of the bend line and the locating lines are 0.50”
from the edge of the part and do not touch one another.

(Place bend and location lines on separate layers and ensure that layer mapping to the
appropriate ProNest machine set-up processes has been completed — see CAD import settings.)

Plot a hard copy to hand in with this assignment.

Also save a digital copy as a *.dxf file in which the dimension layer, notes, and frame are turned
off. Place in a folder for import into ProNest.

2.00 1.50 350

R0.50
Mark Locating Lines_|
Only = Drill Holes
\\\\ 0.25
/(
1.00 W

1.00 Layout Lines for
' Locating Gussets

w
Jl
o
.06 dn pued

N
N

Bend Down
30°

R0.25
— 050 4\\i:7

1.50
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TASK - Processing: For this task ensure that the Hypertherm plasma machine set-up has
been selected. Import the drawing into ProNest and assign the following parameters: Quantity
5, Material MS, Thickness 0.500 in., Class 130 Amp 0,/Air (True Hole).

Name one parameter that is automatically updated in the geometry by ProNest after
assigning the material thickness:

e Leadlength

State the total cut length and cutting time for this part as defined in PN:

Do the figures above include the marking of the bend and locating lines?

TASK - Information: It is often necessary for the programmer to share information with the
machine operator, or other members of the team after creating the nest. Identify the feature in
PN which allows users to most easily share and communicate information such as cut length,
cut time, nest plot, and other nest information:

e Reports
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TASK - Parametric: In a new workspace import an Offset Rectangular to Round transition
Flat Pattern development from the Pipe module:

Use these parameters in Pipe:

= Dimensions
Max Segment Size 2
Rectangle Length 20
Rectangle Width 12
Transition Height 12
Exit Diameter
Exit Center X Offset
Exit Center ¥ Offset
Exit Tilt Angle
Exit Rotation Angle
Rectangle Tilt Angle
Joint Type Side
Skirt Length 1
Skirt Length 2
Skirt Length 3
Left Hand Side Lap
Right Hand Side Lap
Top Side Lap
Weld Gap
Top Collar

- oo o o o ofidio o

Mumber of Pieces

Inside Base / Qutside Top
Length of skirt at point 3

=
=]
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TASK - Modification: Using the provided Hypertherm plasma machine, using the Pipe
Settings function, define the material for the part using 0.125”.

~a0d ce e

Part name:
Rectangle to Round

Cuantity:
1

I (= Open... I l I save.. I
| Settings... | lﬁﬁ Cut Prncess...l

In the Edit Parts List, define the Material to match MS and the Class for the part using “30Amp
02/02”

List the total cut length and production time:

e 116.046; 0:00:35

Recalibrate and record values for MS 0.50”, Class 80Amp 02/Air length and time:

e 116.234;0:02:23

Why is the above cut length different?

e The lead length has increased

TASK - Parts: Begin a new cutting project by opening a new job. Ensure the machine is set to
the provided Hypertherm Plasma. Import the following *.dxf files from the examples folder:

Part Quantity
Brace.dxf 24
Hook.dwg 48
Blade.dxf 18
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TASK - Virtual Shapes: Create the following part in VSP with Quantity 32 and add to the
part list:

Rounded Rectangle

=l Dimensions

Height 5

Width 10

Corner Radius 1 1.5

Corner Radius 2 L5

Corner Radius 3 1.5

Corner Radius 4 i1.5 =

Rounded cormer radius 4 |

= ( addcutout | [ oektecutout |

Part name
Rounded Rectangle

Quantity
33

Cut Process...
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TASK - 2D Pipe: From Pipe, create the flat pattern from the data given below and add to the
part list with a quantity of 7:

Max Segment Size 5 P
Pipe Diameter 10
Pipe Length 25
Left Hand Side Lap 0
Right Hand Side Lap i}
Top Side Lap 0
Bottom Side Lap 0
Weld Gap 0
Mumber of Pieces 1
Angle of Weld Seam 0
—
|
(st ] [ tooeere |
i ’ ! | Partname:
Straight Pipe
Quantity:
5l
U o | [ Esaven ]

| [%] Settings... | [ M. cutProcess... |

Make:
|Bl:lﬂ'| - |

o [ coned |

TASK - Parameters: Ensure all parts are assigned to MS, 0.25 in., 130 Amp 0,/Air (True

Hole), and return to Nesting.
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TASK - Report: Run the Job Summary report on the nest.

What is the True Utilization of the nest?

Name one or more variables that will normally affect True Utilization of a nest:
e Leadlength
e Separation values

e Nesting strategy

Next, clear the nest and re-nest using 2 torches (see Help manual — F1 for more information).
Re-output the Job Summary report and note the corresponding results below:

Number of Torches: 1 2

Production Time Totals: | 1:00:24 0:45:01

Write a statement that explains why single or multiple torches might be selected for various

jobs:

e Choose multiple torches if it allows you to increase overall linear distance cut, however
the nest configuration will dictate the overall time savings from using multiple torches. If
the nest contains parts of varying geometry this may require manual torch parking and
spacing throughout the nest resulting in inefficiencies.
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TASK - Job Overview: Open and explore the file — File -> Open-> Automatic Nesting
(strategy 4) that accompanies ProNest.

How many different parts are to be cut?

What is the total quantity of all parts to be cut?

e 298

Where in PN can you go to find the current nest properties?
e Right click on the selected net tab -> select Nest Properties

e Inthe task bar (ribbon) select View -> Check the Properties box

What is the true utilization of this nest?

e 64.10%

TASK - Separations: Delete the current nest, go to the Separations window and increase
each of the separation values to 0.75 in.

Re-nest the current part list (again using strategy 4) and describe what affect the above changes
have on True Utilization:

e True Utilization is decreased to 19.21%
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